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Problems with our UART implementation

f* Infinite loop */
= Remember the final solution:| ™ Tsas o @asso, vsase ne @asro) )

}

o This solution is a blocking implementation since
USART_Rx will not return until data is received

o Better solution to call USART_Rx function only if a
character can be found in the buffer

o An other good way to use interrupt

= Better to start a new project in the same way
done before

= See the following sides to remember stating a
new project
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Strating with a new project

" File->New->Project->Silicon Labs MCU Project:

#=+ New Silicon Labs Project 1 XK
Project setup ﬁ
Select the board, part, and SDK for the project.
Boards:
Search | hd

_ EFM32 Giant Gecko Starter Kit board (BRD2200A Rev AQ03) G

Part;

‘ Search | W

| EFM32GG990F1024 |

SDEK;
‘Gecko SDK Suite: MCU 5.8.3.0, Micrium OS Kernel 5.7.0 (v2.6.3) (I\Simplicity_studic\devel ‘ @

Manage SDKs..

® < Back Finish Cancel
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Strating with a new project

" File->New->Project->Silicon Labs MCU Project:

«= New Silicon Labs Project O X
Project setup @
Select the board, part, and SDK for the project.

Boards:

Search | v

| EFM32 Giant Gecko Starter Kit board (BRD2200A Rev AQ3) %

Part:

| Search | b

| EFM32GG990F1024 |

SDK:

|Gecko SDK Suite: MCU 5.8.3.0, Micrium OS Kernel 5.7.0 (v2.6.3) (I\Simplicity_studio\devel v| @

Manage SDKs...

®

< Back Finish Cancel

#= New Silicon Labs Project O X
Project setup @
Select the type of project.
Project Type:

@ Empty C Program - Create an empty C executable project.

() Empty C++ Program - Create an empty C++ executable project.
(O Example - Create a working example for the part.

(0 Library - Create an empty static library project.

(O Simplicity Configurator Program - Create a project whose contents are driven from
Simplicity Configurator.

CEEEHETT T © BME-MIT
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Strating with a new project

= Give project name and location, and set
Copy content:

«== New 5Silicon Labs Project O X
Project Configuration @
Select the project name and location.

Project name: | UART_COM ‘

Use default location
ny | CA\Users\krebesz\SimplicityStudio\v4 workspace\UART_COM Browse...
With project files:
(T Link to sources
(O Link sdk and copy project sources
(® Copy contents

@ < Back Next = Cancel
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Project created — start programming

= Main.c can be also renamed to UART _COM.c

= Although an empty C project has been created a
program skeleton is offered automatlcly

ltn Project Explorer 3 | BEE = E' |_| UART_COM.c &2 |
5 STK3700_blink [GNU ARM v7.2.1 - Debug] [EFM32GG990F1024 - ¢|| 1 #include "em device.h"
» &5 STK3700_button [GNU ARM v7.2.1 - Debug] [EFM32GG990F1024 #include "em chip.h"
v % UART_COM [GNU ARM v7.2.1 - Debug] [EFM32GG990F1024 - GEté

& [nklides -int main(void)

L T ™ R P 5 ) A

= CMSIS : { /* Chip errata */
= emlib 7 CHIP Init():
v (== 5IC g
> [g UART_COM.c /* Infinite loop */
10 while (1) {
11 }
12 7}

2

1 s
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Files to be added to the project

= Search the library where Simplicity Studio is
installed

o Contains include (inc: *.c) and source (src: *.h) files:
i:\Simplicity _studio\developer\sdks\gecko sdk_suite\v2.6\platform\emlib\

" Following files have to be drag-and-dropped into

emlib library of the project (see next slide):
o em_cmu.c (clock management unit)

O em_gpio.c

o em_usart.c

O em_core.c

o em_emu.c (energy management unit)

g3z
-~
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Files to be added to the project

= Furthermore they have to be included into the
program:

|5 Project Explorer 2 | 5% ¥ 7 O[5 -UART COMc

| 5 & STK3700 blink [GNU ARM v7.2.1 - Debug] [EFM32GG990F1024 - Gecko SO

. & STK3700_button [GNU ARM v7.2.1 - Debug] [EFM32GGI90F 1024 - Gecko S

, &5 UART_COM [GNU ARM v7.2.1 - Debug] [EFM32GG990F1024 - Gecka SDK S

v & UART_COM_Development [GNU ARM v7.2.1 - Debug] [EFM32GG990F1024
kY Includes

[£ em_device.h

1 #include "em device.h"
#include "em chip.h"
#include "em cmu.h"
#include "em gpio.h"
#include "em usart.h"
#include "em core.h"

lf[—-] aoLn B Lo [N

= CMSIS #include "em emu.h" )
( ~ = emiib N\
b, > [€8 em_cmuc -int main (void)

> g em_core.c

[€ em_emu.c

> [€ em_gpio.c
- g em_system.c

ik
ik
(e

—Q -Elem_ugart.c)

{
/* Chip errata */
CHIP Init():

/% Infinite loop */

w (& SIC while (1) {
» [€ UART DEV_COM.c }
I.I\. ITTADT PRearmtiem~ TRITT ANAKS 77 %4 Meabkii=T TICCEATFAFoAOAr4maaA Freweleom © ¥ }
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Code to start with

Use the following code as a reference for your work (continue from previous result):

#include "em_device.h"
#include "em_chip.h"
#include "em_cmu.h"
#include "em_gpio.h"
#include "em_usart.h"
#include "em_core.h"
#include "em_emu.h"

int main(void)
{

/* Chip errata */
CHIP_Init();

// Enable clock for GPIO
CMU->HFPERCLKENO |= CMU_HFPERCLKENO_GPIO;

// Set PF7 to high
GPIO_PinModeSet(gpioPortF, 7, gpioModePushPull, 1);

// Configure UARTO
// (Now use the "emlib" functions whenever possible.)

// Enable clock for UARTO
CMU_ClockEnable(cmuClock_UARTO, true);

// Initialize UARTO (115200 Baud, 8N1 frame format)

// To initialize the UARTO, we need a structure to hold

// configuration data. It is a good practice to initialize it with

// default values, then set individual parameters only where needed.
USART _InitAsync_TypeDef UARTO init = USART_INITASYNC_DEFAULT;

USART_InitAsync(UARTO, &UARTO_init);
// USARTO: see in efm32ggf1024.h

// Set TX (PEQ) and RX (PE1) pins as push-pull output and input resp.
// DOUT for TX is 1, as it is the idle state for UART communication
GPIO_PinModeSet(gpioPortE, 0, gpioModePushPull, 1);

// DOUT for RX is 0, as DOUT can enable a glitch filter for inputs,

// and we are fine without such a filter
GPIO_PinModeSet(gpioPortE, 1, gpioModelnput, 0);

// Use PEO as TX and PE1 as RX (Location 1, see datasheet (not refman))
// Enable both RX and TX for routing

UARTO->ROUTE |= UART_ROUTE_LOCATION_LOCI;

// Select "Location 1" as the routing configuration

UARTO->ROUTE |= UART_ROUTE_TXPEN | UART_ROUTE_RXPEN;

/* Infinite loop */
while (1) {
}

© BME-MIT
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Setting the terminal program

= Check UART (COM port number and its settings) in
Device Manager in Windows (now it is COM4)

M Device Manager O x
File Action View Help
e @ HE B EX®

@ Cameras A
EH computer

== Disk drives

B8l Display adapters

== DVD/CD-ROM drives

i Firmware

#H Human Interface Devices

“& IDE ATA/ATAPI controllers

== Keyboards

£ 1 Memory technology devices

B Mice and other pointing devices
 Monitors

2P Network adapters

Portable Devices

W Ports (COM & LPT) v
@ JLink CDC UART Port (COM4)
= Print queues w
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Setting the terminal program

= A PC-based terminal program is needed to get
access to COM4 port: an option is putty.exe

&2 PuTTY Configuration ? X B® PUTTY Configuration ? X
Category: Category:
= | Basic options foryour PuTTY session | £ Session | Options controlling local seria lnes
Lo.gglng Specify the tion you want to connectto - Lolgglng Selecta senal line Y
Terminal — 2 3 = Terminal \
.. Keyboard Serial line 'Speed  Keyboard e e |COM4 |
- Bell lcoms ] Lis200 ) - Bell
- Features Connecioniype - Features Configure the seral line
=-Window ; : . =-Window
R (ORaw (O Telnet (ORlogin 0351 ®) Serial s Speed (baud) 115200 |
-+ Behaviour Load. save or delete a stored session 1 i Data bits |3 |
- Translation . - Translation
i Selection Saved Sessions [ Selection i |! |
- Colours | | - Colours : g 1
= Connection - Paiy Hehe =
- Default Settings food |/ :
- Data ! L — - Data Flow control MNone o |
- Proxy - Proxy
- Telnet i - Telnet ‘
--Rlagin Delete & Rlogin \ 5 y
: #-SSH
.. Serial // - Sernal
4
Close window on exit
() Always (i Never (@) Only on clean exit

About Help Cancel . About Help I Open Il Cancel

6
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Non-blocking character reception

= Check our previous solution again
o What does USART Rx do(stay on it by mouse pointer)?

;% Infi loop
while {1} {
USART_Ix{UBRTD, USART_Rx{UERTD}];

} } uintB_t USART Rx (USART TypeDef *usart)
{

while (! (usart—->STATUS & USERT_STRTUS_BXDRTE?]] i
- - — S }
blems % Search  |i2* Call H

E return (uint8 t)usart->BXDATRH;
am Output Console -

}

Press 'F2' for facus

o Operation: remains in while loop until in
USART_STATUS_RXDATAV bit flips to 1, then returns

with the received character (RXDATA)

 See 03_EFM32_Reference_manual EFM32GG-reference_manual.pdf
on page 481 (and next slide)

o Blocking can be avoided if we check the STATUS reg
T © BME-MIT I'hj]- Eﬁéfi{égﬁiiaefészerek 12.slide




Non-blocking character reception

17.5.5 USARTN_STATUS - USART Status Register

oot |5 (g |a|x|x|gs|x|c|n|s|g2e|x ||z |z ||e|e ||~ Jo|o || |~]|-]|o
Reset DDDDDIDFDDDQOD
Access r | | r vt | v | v | v | e | .
F_
=T
5955—2 il _ |58 oo
Name 2|8 |8 Elglg|2|o|B|Z|&
o = < RlE|2 || Ww|W
S = |55 o I8 X |m|<|[X|X
:)}——mm > F)(EI—*E
L | <[ |x o (14
X |8 'F |+
r
| —
7 RXDATAV 0 R RX Data Valid

Set when data is available in the receive buffer. Cleared when the receive buffer is empty.

= Non-blocking solution: check STATUS reg. and call
USART_Rx() function only if incoming character is
available

Tanszék
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Non-blocking character reception

= Search em_usart.h for a function that checks
STATUS register (if available, hopefully it is):

IﬁDm@AMEm |¢QMME' = 1% s

. o° USART_IntDisable(USART_TypeDef*, uint32_t) : voi

o5 USART_IntEnable(USART_TypeDef*, uint32_t) : voi

e° USART _IntGet{(USART_TypeDef®) : uint32_t

oS USART_IntGetEnabled{USART_TypeDef*) : I_l'ﬂ.iiz_i
g TypeDef* yint32 11

Get USART STATUS regilister.

* iparam[in] usart
x Pointer to USART/ULRT peripheral register block.

& @_:tu“n

STATUS register value.

....................................................................................................................

a Meéréstechnika és .
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Non-blocking character reception

" Application of USART_StatusGet() function:

/* Infinite loop */
while (1) {
if {USE&.RT_StatUSGet (UARTO) & USART STATUS RXDRTR‘I] {
USART Tx (UARTO, USART Rx I[UERTU]]
}

}

" Even more elegant solution if we implement an
own non-blocking function to receive characters

int USART RxNonblocking (USART TypeDef *usart)
{

int retVal = -1: inkt ch:
ch = USART RxNonblocking (UARTO) ;
if (usart->STATUS & USART _STATUS RXDATHV) { if (ch !'= jl} [
retvVal = [1nt){usart >RXDATA) ; USART Tx (UARTO, ch):
} = ’ '
t

return retVal; . . .
) Application of non-blocking function

(put it in the main function)

Implementation of non-blocking function
(put it before the main function)

a Meéréstechnika és .
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Non-blocking character reception

= Remark on USART Tx() function:

o If data to be sent is too much even USART_Tx()
function can be blocking — have a look at USART_Tx()

."' *

Inftinite
while (1)} {
//USBRRT StatusGet (USART TypeDef *usart)

if USERT StatusGet (UARTO) & USART STRTUS _RXDATRV) {

MEUERTD USART Rx (UARTO) ) ;

} void USART Tx(USART TypeDef *usart, uintB_ﬁ data)

0T .'ll
= /

ﬂems @ &

nDut,Juthms usart—->TXDATA = (uint32 t)data;
}

Press 'F2' for focus]|

o Clearly seen that blocking may happen but “less
severe” —> USART _STATUS_ TXBL bit is checked in
STATUS register

a Méréstechnika és .
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Non-blocking character reception

O USART_STATUS_TXBL bit (TXBL may appear in other registers- be careful)

17.5.5 USARTN_STATUS - USART Status Register

16

6010 |5 |8 (R |8 (K|88(I|R|V|S|R |22 olg(2la(c|2lo o nfof|v|o|la|-]o
Reset o |lo|lo|lo|lo|lall~b|lojlo|lo|lo|o
Access r | rr | rr | vl | ¥ o | | e | o
’_
=[x
- | E
518 x|x|4|[Z2]_ _18|E|n o
Name = |9 |s|=laB|E | 0|k |22
E:"mﬂfu_{xxl-—_lwl.l—lm
|2 |le o x|2F X128 |< X |8
:'—mmmx |—.')(El—ﬂ:
LL{KK o o
a3
3¢ | [ k=
Bl
6 TXBL 1 R TX Buffer Level

Indicates the level of the transmit buffer. If TXBIL is cleared

TXBL is set whenever the transmit buffer is half-full or empty.

TXBL is set whenever the transmit buffer is empty,]and if TXBIL is set,

See 03 _EFM32_Reference_manual EFM32GG-reference_manual.pdf
on page 481

© BME-MIT
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Non-blocking character reception

o Operation of data transmission:

 Generated data is loaded into TX
Register only if TX Register is empty

— Otherwise data in TX Register is
overwritten and data loss may occur

. !f TX.Buffer is emp’lfy data is loaded
into it from TX Register

* From TX Buffer data is sent out via
the communication line (UART)

* R=115200bps->1byte needs 70us
* T clk=1/14MHz=70ns->1000cycles

per bytel!ll
TX Buffer to send data to comm. line ‘ I I I I

A - Méréstechnika és .
fﬂ%ﬂﬂ © BME-MIT Informaciés Rendszerek 1 8S||de
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Interrupt-based character reception

= Problem with non-blocking character reception
o If the main program executes a long-lasting task before
repeated checking of character is done data loss may
occur

o To prevent that kind of data loss application of
interrupt can be a solution

Peripheral gh Cortex- M3 NVIC

[ FSn] | [ IFCIn] \L IEN[n] \l +
ﬂ [| sETENAIN]|CLRENAIN] |
ﬁ
h 4 ;D Active interrupt T
Int t set  clear I IRQ :
cgn?!rirt?cfn IF[n] _D 5 D — c:ar interrupt

SETPEND[n]/ CLRPEND[n]

Software generated interrupt

a Méréstechnika és .
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IT initialization for a peripheral

= |nitialization of IT in a general case:

o Enabling peripheral (turn perif. on, config., €tC.)| . iousy (uagT init
o Determination of IT-handling function
C
o Clear of IT flag belonging to the certain IT 0
M
* An IT request may be stuck from a previous state that can E
cause problem since after enabling IT a false interrupt can | °
take action. A stuck IF can be the consequence of a non- N
initialized peripheral (e.g. IT occurs on a floating input) v(\)/
o Enabling the IT of a certain peripheral
. . L
o Clearing of global IT flag (if needed) A
o Enabling of global IT :
R

NOTE: THIS SLIDE COMES FROM THE INTERRUPT TOPIC OF LECTURES
USE THAT LECTURE AS A REFERENCE IF NEEDED

a Méréstechnika és .
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Interrupt-based character reception
" |Interrupt has to be enabled for UART

17‘4 RegiSter Map gsgil;l\;ljialgeference_manuaI_EFM3ZGG—reference_manuaI.pdf

The offset register address is relative to the registers base address.

Name Type

Ox040 USARTn_IF R Interrupt Flag Register

Ox044 USARTn_IFS W1 Interrupt Flag Set Register
Ox048 USARTn_IFC W Interrupt Flag Clear Register
0x04C [ USARTn_IEN ] RW Interrupt Enable Register

17.5.20 USARTnN_IEN - Interrupt Enable Register

03 _EFM32_Reference_manual _EFM32GG-reference_manual.pdf

See page 490

pr—
odc |58 (R(RIN(88|3 |8 |¥|s|s|ee|]ele|z|ee|z|e]o o |~ oo |« |afla]-|o
Reset ol|lo|lo|lo|lo|o|ojeo|o|clle]e | e

L || |.|.|.|.|.|.—‘E
Name b%ﬁﬂiﬂi%o:‘oi"gﬁlg
Olo |z ¥ |2 |F (X2 2 | ElelE | F

0 K

S—

2 RXDATAV 0 RW RX Data Valid Interrupt Enable

Enable interrupt on RX data. o)

["III Tanszék



Interrupt-based character reception

o Check em__usart.h for interrupt enable function

= : 524 Tparam[In] USartT
&H No Adapters  |5= Outline i3 | o | 25 +*  Ppointer to USART/UART peripheral register block.
EHlES e ¥ B26 *
++ USART_InitPrsTrigger(USART_TypeDef*, const USAR] ~ g27 * @pa:am [1n] flags
e ° USART_InitlrDA(const USART_InitirDA_TypeDef*) : v Bz * ISERT/UART interrupt source(s) to enable. Use one or more valid

nter _l}__L. f ags f L.]"'l— USART module (I C‘PP'_' IF nnn) OR'ed to f—t]

«««««««««««««««««««««««««««««««««««««««««««««««««««««««««««««««««««««««««««««««««««««««««««««««««««««««

___STATIC INLINE void [ENygddas.Fio0 (USART TypeDef *usart, uint32 t flags)

& USART_IntClear(USART _TypeDef*, uint32_t) : void
of USART_IntDisable{USART_TypeDef* uint32_t) : voic
& % USART _IntEnable(USART TypeDef®, uint32_t) : void
o USART_IntGet(USART_TypeDef#) : uint32_t

usart->IEN |= flags:;
of USART_IntGetEnabled(USART_TypeDef*) : uint32 _t

}

o Insert USART _IntEnable() function
flags = register content, here the 2" bit is interesting
(see previous slide)

* Check efm32_ gg usart.h

#define USART IEN RXDATAV (0x1UL << 2) /**< RX Data Valid Interrupt Enable */

* Code to be applied:

//USBRRT IntEnable (USART TypeDef *usart, uint3Z t flags)
USART_IntEnahle_ (UARTO, USART IEN RXDATAV)

i /* Infinite loop */
i while (1) {

a Meéréstechnika és .
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Interrupt-based character reception

" Interrupts have to be cleared (all ITs) for UART

o Check em_usart.h for interrupt clear function

Lﬁ-tNo Adapters &= Outline 32| _ =5 7,_--,_:_ ¢ @param[in] flags
% w0 ¥ T 787 Pending USERT/UART interrupt source(s) to clear se oI
++ USART_InitPrsTrigger(USART_TypeDef*, const USART ~ interrupt flags for the USART module (USART IF nnn)

T B T T T T

e % USART InitirDA{const USART_InitirDA_TypeDef*) : vt
(i USART IntClear{USART_TypeDef*, uint32_t) ; void
ef USART_IntDisable(USART_TypeDef*, uint32_t) ; void

__STATIC INLINE void

I
1

> #if defined (USART HAS SET CLEAR)

e
Py b LT [ s E, o [
COR'ed togethe
Pl el S P e PR

e el R (USART TypeDef *usart, uint32_t flags)

© ® USART StatusGet(USART TypeDef#)

uint32 t

of USART_IntEnable(USART _TypeDef*, uint32_t) : void

] usart->IF CLR = flags:
ol USART_IntGet{USART_TypeDef#) : uint22 t 4 #else
o USART IntGetEnabled(USART TypeDef*) : uint22 1 : usart[>1 FC = flags: ]
e ¥ USART_IntSet(USART_TypeDef*, uint32_t) : void 6 f#endif

!

17.5.19 USARTn_IFC - Interrupt Flag Clear Register

ons |53 (g(g|n|ge|z||s]s][alee|se|e|z]eja|z]e]a||~]o]o]<]a]|a]|]0o
Reset oloo|lo|lo|lo|lolo | oo o
ALcess =z zlzlzlz|zl=z |z |2 z

-
Name 5%%%%55;&5‘ ﬁ
Olo |z |HI|E|R|FE ||k L

o

03 EFM32 Reference manual EFM32GG-reference_manual.pdf See page 489
..... ETE chmika €s .
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Interrupt-based character reception

o All bits in USARTn_IFC register have to be cleared

* A define can be found in efm32gg_usart.h for that purpose:
#define USART IFC MASK O0x00001FF9UL /**< Mask for USART IFC */

o Insert USART _IntClear() function after UART init
o Code to be applied:

//USART IntClear (USART TypeDef *usart, uint32 t flags)
USART IntClear (UART0O, USART IFC MASK);

//USART IntEnable (USART TypeDef *usart, uint32 t flags)
USART IntEnable (UART0, USART IEN RXDATAV);

/* Infinite loop */
while (1) {

o This step requires extra care: it is very probable that
the program would work but in general, not clearing IT
flags can cause a trouble o

T © BME-MIT [hil FomseeReriszeee  24.slide
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Interrupt-based character reception

JUST DONE

COMING NEXT

Peripheral gh Cortex- M3 NVIC

BETEREDRE

| SETENA[n]/ CLRENA[n] | B

Interrupt set  clear

\;D Active interrupt .
IRQs .

condition IF[n] » - cletr interrupt

[ SETPEND[n]/ CLRPEND[n]

|

Software generated interrupt

y

¥
N\

So far UART peripheral-related IT has been dealt
with

From now let’s see the core-related IT

a Méréstechnika és .
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Interrupt-based character reception

= Core-related IT- IT for the UART has to be enabled

o em_decive.h + F3 (among included header files in at

the top of the program)

-> find in it efm32gg990f1024.h + F3

-> find in it core_cm3.h + F3
NVIC functions are needed

" |n core ~cm3.c searc

#H No Adapters = Qutline &3 |

:l"‘}&'“@u@#v

# NVIC GetVector
# NVIC_USER_IRQ _OFFSET

o5 _ NVIC_SetPriorityGrouping{uint32_t) : void
e ° _NVIC_GetPriorityGrouping(void) : uint32 1

e ° _ NVIC_EnablelRQ(IRQn_Type) : void

® ° _ NVIC_GetEnablelRQ(IRQn_Type) : uint32_t

@ ® _NVIC_DisablelRQ{IRQn_Type) : void

e ¥ _NVIC_GetPendingIlRQ(IRQn_Type) : uint32_t

e % NVIC SetPendinglRQ(IROn Type) : void

h for

& f‘l
___STATIC

if

{

}

Enable Interrupt

1s Enables a device specific interrupt in the
' IRQn Dewvice specific interrupt num
n must not be negative.

_INLINE wvoid NVIC EnableIRQIES:{eRNG I u:10)i}]

({int32 t) (IRQn) >= 0)

NVIC->ISER[{{ (Llil’lt32_t} IEgn) >> 5JUL)] = EuirltB?._tJ

© BME-MIT
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Interrupt-based character reception

o In core_cm3.c search for
* void _ NVIC EnableIRQ (IRQOn Type IRQn)

— IRQn Type IRQn + F3 to check the possible ITs to find:
UARTO RX IRQn = 20, /*!< 20 EFM32 UARTO RX Interrupt */

o Code to be applied:

//USART IntClear (USART TypeDef *usart, uint32 t flags)
USART IntClear{UﬁRTD _USART TFC MESK}

USART IntEnable (USART TypeDef *usart, uint32 t flags)
USRRT IntEnahle{UﬁRTD USART IEN RXDRTA?]

[ /voi NVIC EnableIRO(IROn Type IEON)
H?IC EnablelRQ{UﬂRTﬂ RX IRQH}

£% Imfinite loop %/
while (1) {
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Interrupt-based character reception

= Core-related IT—IT flags has to be cleared

o em_decive.h + F3 (among included header files in at
the top of the program)
-> find in it efm32gg990f1024.h + F3
-> find in it core_cm3.h + F3
NVIC functions are needed

" |n core cm3 C search for

E{ND Adapters D—C’”ﬂ'"e | 1587 \brief Clear Pending Interrupt
= 1% k\ ‘&a\ @ 'iﬂi =1l 1588 ‘details Clears the pending bit of a device specific inte:x
e® _NVIC_GetPendinglRQ(IRQn_Type) : uint32_t ~ 156889 \param [in] IRgn Device specifiec interrupt number.
@® _NVIC_SetPendinglRQ(IRQn_Type) : void 1590 ".::1-::11:& IRQn must not be negative.
i)

e® _NVIC_ClearPendingIRQ(IRQn_Type) : void

e® _NVIC GetActive(IRQn_Type) : uint32_t

e ® _ NVIC_SetPriority(IRQn_Type, uint32_t) : void

of _ NVIC_GetPriority(IRQn_Type) : uint32 1

o NVIC_EncodePriority{uint32_t, uint32_t, uint32_t) : ui
o NVIC_DecodePriority(uint32_t, uint32_t, uint32_t* co
®® _ NVIC_SetVector(IRQn_Type, uint32_1) : void

__STATIC TINLINE void NVIC ClearPendingIRQEENIeiQuin yel-Sunle)e)

if ((int32 t) (IRQn) >= 0)
f

NVEC—)ECPR[{(I[uint32_t,'IIRQn} »>»> 5UL)] = (uint32_t} {1UL <
}

}
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Interrupt-based character reception

o In core_cm3.c search for
* void _ NVIC ClearPendingIRQ (IRQn Type IRQn)

— IRQn Type IRQn + F3 to check the possible ITs to find:
UARTO RX IRQOn = 20, /*!< 20 EFM32 UARTO RX Interrupt */

o Code to be applied:

( //USART IntClear (USART TypeDef *usart, uint32 t flags) N
USI—!.RT IntClear (UARTO, _USART TFC MFLSK}
UART Perif. IT
fUSART IntEnable (USART TypeDef *usart, uint32Z t flags) clear and enable
\ USI—LRT IntEnahle (URRT(, USART IEN RXDATAV); y
4 [T T OUE = ™
]:WIC ClearPendlngIRQ{UART{] RX IRQH}
Proc. core IT
//woid _ NVIC EnableIRQ(IRQn Type IRQn) clear and enable
NVIC EnableIRQ(UARTO RX IRCn);
. _ _ J
% Infinite loop */
while (1) {
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Interrupt-based character reception

" |Ts have just been correctly configured
o When a character is received at UARTO, IT is generated

= |T function has to be implemented
o What should happen when IT event occurs
o Check startup_gcc_efm32gg.s in Project Explorer

[ Project Explorer i3 . B% ¥ 7 0| [d*UART.COMc | em_deviceh |l efm329g990f1.. | [ em_usartc T efm32gg_usarth
> &5 STK3700_blink [GNU ARM v7.2.1 - j'.: 103 .long I2C1 IRQHandler F% 10 — IZEl %Y
& STK3700 button [GNU ARM v7.2.1-11 104 .long GPIO ODD IRQHandler f* 11 — GPLD ODD */
» B UART_COM [GNU ARM v7.2.1 - Debu{| - -iﬁng Eﬁié_iigimier *’ ¥ 12 - ZEEEA b
I .long s andler *.13 = TIMERZ *y
N ﬁyfgr‘c?mﬁe"e"mme”t GNUARME 507 .long TIMER3 IRQHandler /* 14 — TIMER3 */
wy Binanes 108 .long USART1 RX IRQHandler /* 15 — USBRT1 RX */
kl Includes 10¢ .long USART1 TX IRQHandler /* 16 — USARTL TX */
v = CMSIS 13.0 .long LESENSE_IRQHandler /% 17 — LESENSE */
v (= EFM32GG 111 .long USART2 RX IRQHandler /% 18 — USART2 BX %/
| B startup gec efm32ags 112 .long _USART2 TX TROHandler /* 19 — USBRT2 TX */
i T 113 .long UART0 EX IRQHandler /* 20 — UARTO RX */
» e system_efm32gg.c L = y =iml s =n
. . 114 .long URZRT0D TX IRQHandler * 21 — UARTD TX */
il 115 .long UART1 RX IROHandler /* 22 — UART1 RX */
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Interrupt-based character reception

o Check startup _gcc_efm32gg.s in Project Explorer
o Search for UARTO_RX_IRQHandler:

Lr:. Prtyec“t Explorer 35| = q{'{a ] |_| *UJART CDM C ‘@ﬂﬁ__gﬁle‘u’ice.h ""ml emeZggE!Q[}ﬂ... | |£| em_usart.c “@ emeZ_g_g usart.h
> 5 STK3700_blink [GNU ARM v7.2.1 - ;.e-_ 103 .long I2C1 IRQHandler ¥ 10 — 121 */
&5 STK3700 button [GNU ARM v7.2.1 -] 104 .long GPIO ODD IRQHandler f* 11 — GEIO OBbD *f
@ UARTCOM GNU ARM 721 -Detuf| 105 -long  TIMERL IRgHandler ik
i o Jl TOE .long o andler F*:AF = TIMERE ¥
V@tf‘ﬁ_r-c?m-De”emme”t GNUARME 107 .long TIMER3 IRQHandler /* 14 — TIMER3 */
o Binanes 108 .long USART1 RX IRQHandler /* 15 — USART1 RX */
il Includes 109 .long USART1 TX IRQHandler /* 16 — USART1 TX */
v = CMSIS 110 .long LESENSE_IRQHandler /* 17 — LESENSE */
~ = EFM32GG 111 .long USARTZ RX IRQHandler /¥ A8 — USART2 BX ¥
' [ startup_gcc_efm32ggs 112 .long USART2 TX TROHandler /* 19 — USART2 TX */
> B system eim3dhg.c ' %%3 .long UART0 RX IRQHandler /¥ 20 — :RRT?_RE *{
= i;ﬂ .long UART( TX IRQHandler A 21 — DARTO TX */
& cmlib .long UART1 RX IROHandler /* 22 — UART] RX */

o UARTO_RX IRQHandIer is @ weak function so |t can be
overdefined in the program without causing any error:

/* Macro to define default handlers. Default handler
* will be weak symbol and just dead loops. They can be
o overwritten by other handlers.
+ lln'

.macro def irg handler handler name
.weak \handler name
.Set \nandler name, Default Handler o e _
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Interrupt-based character reception

o Implementation of IT function in the program code

o UART_RX_IRQHandler function has to be defined
before the main function

* During IT the received data has to be sent to UART
o Code to be applied:

uintB_t rx data; [/ a wariable is defined for USART Tx data

USART Tx(UARTO, rx data); // rx data is sent to UARTO
USART IntClear(URRTO, USART IFC MASK); // IT flag 1is cleared

}

;f {whose Lype 15 wmnli8 t)
=void UARTO RX IRQHandler (void){ // definition of IT function:
rXx data=USART Rx (UARTO); // data read from URRTO and stored in rx data

o Note: no input parameter and no return value
-> void func(void){
what happens during IT;
clear IT flag; }
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Appendix: code —a working version

#inciude "em_device.h"
#include "em chip.h"
#include "em cmu.h"
#include "em gpio.h"
#include "em usart.h"
#include "em core.h"
#include "em emu.h"

[ S R

[ %]

=]

]

g uintB_t rx data;

“void UARTO RX IRQHandler (veoid) {

iz rx data=USART Rx (UARTO);

13 USART Tx (URRTO, rx data);

14 USART IntClear (URRTO, USART IFC MASK);
15 }

10

—]

=int main (void)

{

\\\\\\\\\\\

CHIP Init();

2

[/ Enable clock for GFIO
CMU->HFPERCLEENDO |= CMU_HFPERCLKEHD_GPIG;

[S =

// Set PF7 to high
GPIO_PinMocdeSet (gpicPortF, 7, gpioModePushPull, 1);

[ LS

// Configure UARTO
G // (Now use the "emlib" functions whenever possible.)
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Appendix: code —a working version

// Enable clock for UARTO
CMU ClockEnable (cmuClock UART(C, true);

// Initialize UARTO (115200 Baud, B8N1 frame format)

// To initialize the UARRTD, we need a structurs to hold
// configuration data. It is a g:.ﬁ practice to initialize it with

// default values, then set individual parameters only where needed.
USART InitAsync TypeDef UARTO init = USART INITASYNC DEFAULT;

USARI_InitAsync{UERTD, &UERTU_init};
// USBRTO: see in efm32ggfl024.h

// Sset TX (PE0)} and RX (PEl) pins as push-pull output and input resp.
// DOUT for TX is 1, as it is the idle state for UART communication

GPIO_ PinModeSet (gpioPortE, 0, gpioModePushPull, 1);

// DOUT for RX is 0, as DOUT can enable a glitch filter for inputs,
// and we are fine without such a filter

GPIO PinModeSet (gpioPortE, 1, gpiocModeInput, 0);

// Use PED as TX and PEl as EX (Location 1, see datasheet (not refman))
// Enable both RX and TX for routing

UART(O->ROUTE |= UERT_RGUTE_LDCATIGN_LGCI;
// Select "Location 1" as the routing configuration

UARTO->ROUTE |= UART ROUTE TXPEN | UART ROUTE RXPEN;
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Appendix: code —a working version

58 //USART IntClear (USART TypeDef *usart, uint32 t flags)
54 USART Intclear (UARTO, _USI—':.R'I'_IFC_I-."LASK},

6l //USART IntEnable (USART TypeDef *usart, uint32 t flags)
62 HSI—;RT_II'LtEnablE (URRTO, USERT_IEN_RKDATR‘H;

64 /fvoid _ NVIC ClearPendingIRQ(IRQn Type IRQOn)

65 __RVIC ClearPendlngIRQ{UﬂRTD RX IRQn);

66

67 //void NVIC EnableIRQ(IRQn Type IRQn)

(efa] _ NVIC EnablEIRQ{UARTE} RX IRON) ;

70 /* Infinite loop */

71 while (1) {

T2 //USRRT StatusGet (USART TypeDef *usart)

73 [AiE L'-..-SE*._R'T' ““t-:lth:th'T_,'BRn|,l & T bBR-_STRTUE_RKLATPf‘J i |
T4 s USRRT Tx (OARTO, USRRT RX (OBRRTOD)} ) ;

75 i il

76 }

77 1

Tanszék
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